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1. Penting

Buku petunjuk elektronik ini ditujukan untuk
siapapun yang menggunakan monitor Philips.
Luangkan waktu untuk membaca panduan
pengguna sebelum menggunakan monitor.
Panduan tersebut berisi informasi dan catatan
penting tentang cara mengoperasikan monitor.

Jaminan Philips berlaku pada produk yang
penggunaannya ditangani dengan baik sesuai
dengan petunjuk pengoperasian dan atas
presentasi faktur asli atau resi yang menunjukkan
tanggal pembelian, nama dealer, nomor model,
dan nomor produksi produk.

1.1 Tindakan pencegahan dan
pemeliharaan

() Peringatan

Penggunaan kontrol, penyesuaian, maupun
prosedur selain yang dijelaskan dalam
dokumentasi ini dapat mengakibatkan sengatan
listrik, bahaya listrik, dan/atau bahaya mekanis.

Baca dan ikuti petunjuk ini saat menyambungkan
dan menggunakan monitor komputer.

Pengoperasian

* Jauhkan monitor dari sinar matahari
langsung, kompor, maupun sumber panas
lainnya.

*  Pindahkan objek apapun yang dapat jatuh
ke lubang ventilasi atau mungkin mencegah
pendinginan elektronik yang benar pada
monitor.

* Jangan halangi lubang ventilasi pada kabinet.

* Saat menetapkan posisi monitor, pastikan
konektor daya dan stopkontak mudah
dijangkau.

* Jika mematikan monitor dengan melepaskan
kabel daya atau kabel daya DC, tunggu
selama 6 detik sebelum memasang
kabel daya atau kabel daya DC untuk
pengoperasian biasa.

*  Selalu gunakan kabel daya yang disetujui dan
disediakan oleh Philips. Jika kabel daya tidak

ada, hubungi pusat layanan setempat. (Lihat
Pusat Informasi Layanan Pelanggan)

* Jaga agar monitor terhindar dari getaran
kencang atau kondisi berbahaya lainnya
selama pengoperasian berlangsung.

* Jaga agar monitor tidak terjatuh atau
terbentur selama pengoperasian atau
pengiriman.

Pemeliharaan

*  Untuk melindungi monitor dari
kemungkinan kerusakan, jangan letakkan
benda berat di atas panel LCD. Saat
memindahkan monitor, pegang bingkai
untuk mengangkat, jangan angkat monitor
dengan meletakkan tangan atau jari pada
panel LCD.

* Lepas sambungan monitor jika Anda tidak
akan menggunakannya dalam waktu lama.

* Lepas sambungan monitor jika Anda
akan membersihkannya dengan kain yang
lembab. Layar dapat dibersihkan dengan
kain yang kering saat dimatikan. Namun,
jangan pernah gunakan larutan organik,
seperti alkohol atau cairan beramonia untuk
membersihkan monitor.

*  Untuk menghindari risiko sengatan listrik
atau kerusakan permanen, jangan biarkan
monitor terkena debu, hujan, atau air,
maupun berada dalam lingkungan dengan
kelembaban berlebihan.

* Jika monitor basah, segera seka dengan kain
kering.

* Jika benda asing atau air masuk ke dalam
monitor, segera matikan daya dan lepas
kabel daya. Setelah itu, keluarkan benda
asing atau air tersebut, lalu bawa ke pusat
pemeliharaan.

* Jangan simpan atau gunakan monitor di
lokasi yang bersuhu panas, terkena sinar
matahari langsung, atau bersuhu sangat
dingin.

*  Untuk memelihara performa terbaik
monitor dan memperpanjang masa
pakainya, gunakan monitor di lokasi dalam
kisaran suhu dan kelembaban berikut.

. Suhu: 0-40°C 32-95°F

. Kelembaban: 20-80% RH



*  PENTING: Aktifkan selalu program
screensaver bergerak bila Anda
meninggalkan monitor. Aktifkan selalu
aplikasi refresh layar berkala jika monitor
akan menampilkan konten statis yang tidak
berubah. Tampilan gambar diam atau
gambar statis yang tidak berubah dalam
waktu lama dapat menimbulkan “efek
terbakar”, disebut juga “jejak gambar” atau
“bayangan”, di layar.

"Efek terbakar", "jejak gambar", atau
"bayangan" adalah fenomena umum dalam
teknologi panel LCD. Dalam sebagian besar
kasus, “‘efek terbakar”, “jejak gambar”,

atau “bayangan’ akan menghilang secara
bertahap dalam waktu tertentu setelah daya
dimatikan.

(D Peringatan

Gejala “efek terbakar”, “jejak gambar'”, atau
“bayangan’ yang fatal tidak akan hilang dan tidak
dapat diperbaiki. Kerusakan yang disebutkan di
atas tidak tercakup dalam jaminan.

Layanan

*  Penutup casing hanya dapat dibuka oleh
teknisi ahli.

* Jika harus memperbaiki atau mengintegrasi
dokumen, hubungi pusat layanan setempat.
(lihat bab "Pusat Informasi Konsumen")

*  Untuk informasi pengiriman, lihat "Spesifikasi
Teknis".

* Jangan tinggalkan monitor di dalam mobil/
bagasi di bawah sinar matahari langsung.

€ Catatan

Hubungi teknisi servis jika monitor tidak
beroperasi secara normal atau Anda tidak yakin
dengan prosedur yang harus dilakukan bila
petunjuk pengoperasian yang diberikan telah
diikuti.

1.2 Keterangan Penulisan

Subbab berikut menjelaskan konvensi penulisan
yang digunakan dalam dokumen ini.

Catatan, Perhatian, dan Peringatan

Dalam buku petunjuk ini, beberapa teks mungkin
disertai ikon dan dicetak dengan huruf tebal atau
miring. Teks tersebut berisi catatan, perhatian,
atau peringatan yang digunakan sebagai berikut:

© Catatan

lkon ini menunjukkan informasi penting dan
tips yang akan membantu Anda memanfaatkan
sistem komputer dengan lebih baik.

@ Perhatian

lkon ini menunjukkan informasi yang
memberitahukan Anda tentang cara menghindari
kemungkinan kerusakan perangkat keras atau
hilangnya data.

€ Peringatan

lkon ini menunjukkan kemungkinan cedera

dan memberitahukan Anda tentang cara
menghindarinya.

Beberapa peringatan mungkin ditulis dalam
format lain dan mungkin tidak disertai dengan
ikon. Dalam hal ini, penulisan peringatan tertentu
diwajibkan oleh peraturan pemerintah terkait.



1.3 Pembuangan produk dan materi
kemasan

Waste Electrical and Electronic Equipment-
WEEE

This marking on the product or on its
packaging illustrates that, under European
Directive 2002/96/EC governing used electrical
and electronic appliances, this product may
not be disposed of with normal household
waste.You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping off
such waste electrical and electronic, contact
your local government office, the waste disposal
organization that serves your household or the
store at which you purchased the product.

Your new monitor contains materials that can
be recycled and reused. Specialized companies
can recycle your product to increase the
amount of reusable materials and to minimize
the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.

Please find out about the local regulations on
how to dispose of your old monitor and packing
from your sales representative.

Recycling Information for Customers
Your display is manufactured with high quality

materials and components which can be
recycled and reused.

To learn more about our recycling program

please visit www.philips.com/about/sustainability/
recycling.



2 Memasang monitor 2] Memasang dudukan dasar

1. Letakkan monitor menghadap ke bawah
pada permukaan yang halus dan lembut
agar layar tidak tergores atau rusak.

2.1 Pemasangan

Bl Isi kemasan

Quick E
Start

'''' = = 2. Pegang penyangga dudukan dengan kedua
T i tangan, lalu masukkan penyangga dudukan

dengan kuat ke dalam batang dudukan.

(1) Pasang dudukan secara hati-hati
ke batang dudukan hingga kaitnya
mengunci dudukan.

(2) Gunakan jari untuk mengencangkan
sekrup yang terdapat di bagian dasar
dudukan, lalu amankan dudukan ke

Kabel audio batangnya dengan kuat.
(opsional)

VGA (opsional) DVI (opsional)




H Menyambungkan ke PC

Model 227E3L:

PHILIPS

(1] Input daya AC
Input VGA
Input DVI-D
Kunci antipencurian Kensington

Model 227E3LH:

PHILIPS

(1] Input daya AC
Input VGA
Input DVI-D
Input HDMI
(5] Input Audio
Output audio
Kunci antipencurian Kensington

Model 227E3LPH:

PHILIPS

o 000
rﬂm C’:Q?Q
o Efﬂg

(1] Input daya AC

Input VGA
Input DVI-D

O input HOMI

Output audio HDMI
Kunci antipencurian Kensington

Menyambung ke PC

1.

Sambungkan kabel daya dengan kuat ke
bagian belakang monitor.

Matikan komputer dan lepas kabel daya.
Sambungkan kabel sinyal monitor ke

konektor video di bagian belakang
komputer.

Sambungkan kabel daya komputer dan
monitor ke stopkontak di sekitar.
Hidupkan komputer dan monitor. Jika
monitor menampilkan gambar, berarti
pemasangan telah selesai.



2.2 Mengoperasikan monitor

PHILPS

(1] Keterangan produk bagian depan
Model 227E3L:

Model 227E3LH:

(5]

/v /A 17/4 /0K [0}
I | [\ | |
(7] (6] o O (2] o

Menghidupkan dan mematikan
|

o O daya monitor.

@ |©)/0K|Mengakses menu OSD.
Kembali ke tingkat OSD

o < sebelumnya.

Menyesuaikan volume suara

o 1q speaker:

© | A V¥V |Menyesuaikan menu OSD.

0@ ©® |Mengubah sumber input sinyal.
Smartlmage Lite. Ada tiga mode
yang dapat dipilih: Standard

o @ (Standar), Internet, dan Game
(Permainan).

/e\

@/v /A /4 /0K [0)
| I [\ | |
(7] (6] O e o o

Menghidupkan dan mematikan
|

o © daya monitor.

O &)/0K|Mengakses menu OSD.
Kembali ke tingkat OSD

o < sebelumnya.

O | [ |[Beralih ke tampilan 4:3.

© | A V¥V |Menyesuaikan menu OSD.

O ©® [Mengubah sumber input sinyal.
Smartlmage Lite. Ada tiga mode
yang dapat dipilih: Standard

0 & (Standar), Internet, dan Game
(Permainan).

Model 227E3LPH:

(5]

/v /A SENSOR/ € /0K [0)
| | [\ | |
(7] (6] © © 0 o

Menghidupkan dan mematikan
I

o o daya monitor:

©® /0K |Mengakses menu OSD.
Kembali ke tingkat OSD

o < sebelumnya.

Menetapkan tingkat sensor untuk

O | SENSOR kontrol otomatis cahaya latar.

© | A V¥V |Menyesuaikan menu OSD.

O | ©® |Mengubah sumber input sinyal.
Smartlmage Lite. Ada tiga mode
yang dapat dipilih: Standard

0 e (Standar), Internet, dan Game
(Permainan).




2] Keterangan On Screen Display

Apakah yang dimaksud dengan OSD (On-
Screen Display)?

OSD (On-Screen Display) adalah fitur yang
terdapat pada semua monitor LCD Philips.
Pengguna akhir dapat menggunakannya untuk
menyesuaikan performa layar atau memilih
fungsi monitor secara langsung melalui jendela
petunjuk di layar. Antarmuka tampilan di layar
yang mudah digunakan muncul seperti di bawah
ini:

Model 227E3L:

Model 227E3LPH:

Petunjuk dasar dan mudah pada tombol
kontrol

Pada OSD yang ditampilkan di atas, Anda
dapat menekan tombol ¥ A pada bezel depan
monitor untuk menggerakkan kursor, lalu tekan
tombol OK untuk mengonfirmasikan pilihan
atau perubahan.

Menu OSD

Berikut adalah tampilan keseluruhan dari
struktur On-Screen Display. Anda dapat
menggunakannya sebagai referensi bila ingin
melakukan penyesuaian lainnya nanti.

Main menu Sub menu
Power Sensor |: On — 04
Off
(available for selective models)

— VGA
Input

[— DVI (available for selective models)

L— HDMI (available for selective models)

r— Picture Format — Wide Screen, 4:3
Picture

F— Brightness — 0~100

— Contrast — 0~100

[— SmartResponse ~ —— On, OFf (available for selective models)

“— SmartContrast — On, Off

r— Volume — 0~100 (available for selective models)
Audio

— Stand Alone — On, Off

— Mute — On, Off

— Color Temperature — 6500K, 9300K
Color

— sRGB

— User Define Red: 0~100

E Green: 0~100
Blue: 0~100

Language — English, Espafiol, Frangais, Deutsch, ltaliano,

Portugués, Pycckuit, B#ERRL, Turkge

r— Horizontal — 0~100
OSD Settings
— Vertical — 0~100
— Transparency — Off1,2,3,4
— OSD Time out — 5,10,20, 30, 60
Setup — Auto
— Power LED — 0,1,2,3,4
— Over Scan — On, Off (available for selective models)
— H. Position — 0~100
— V. Position — 0~100
[— Phase — 0~100
— Clock — 0~100
— Resolution Notification — On, Off
— Reset — Yes, No
L— Information




El Pemberitahuan resolusi

Monitor ini dirancang untuk memberikan
performa optimal pada resolusi aslinya, yakni
1920 x 1080 pada 60 Hz. Bila monitor
dihidupkan pada resolusi yang berbeda, layar
akan menampilkan peringatan: Gunakan 1920 x
1080 pada 60 Hz untuk hasil terbaik.

Tampilan peringatan resolusi asli dapat
dinonaktifkan dari Setup (Konfigurasi) dalam
menu OSD (Tampilan di Layar).

a Fungsi Fisik

Kemiringan

2.3 Melepas Dudukan dan Dudukan
Dasar

El Melepas Dudukan Dasar

Sebelum mulai membongkar penyangga
monitor, ikuti petunjuk di bawah ini agar
terhindar dari kemungkinan kerusakan atau
cedera.

1. Letakkan monitor menghadap ke bawah
pada permukaan yang halus agar layar tidak
tergores atau rusak.

2. Lepas penyangga dudukan dari batang
dudukan dengan cara:

(1) Menggunakan jari untuk melonggarkan
sekrup yang terdapat di bagian dasar
dudukan.

(2) Menggeser ke atas dan bawah secara
perlahan untuk melepas kait yang
mengunci dudukan, lalu menarik
dudukan dari batang dudukan.




2. Memasang monitor

2] Melepas dudukan

1. Anda dapat menggunakan obeng minus
pada kedua lubang pelepas di penutup
engsel, lalu membuka penutup engsel secara
hati-hati hingga terlepas.

2. Lepas 4 sekrup, lalu lepas dudukan dari
monitor.




3. Pengoptimalan Gambar

3.1 Smartlmage Lite

El Apakah yang dimaksud dengan
SmartContrast?

Smartimage Lite memberikan preset yang
mengoptimalkan layar untuk berbagai jenis
konten dengan menyesuaikan kecerahan,
kontras, warna, serta ketajaman secara real
time dan dinamis. Meskipun Anda bekerja
dengan aplikasi teks, menampilkan gambar,
atau menonton video, Philips Smartlmage
Lite memberikan performa monitor yang
dioptimalkan.

E1 Mengapa saya memerlukannya?

Anda memerlukan monitor yang memberikan
tampilan semua jenis konten favorit yang
dioptimalkan. Perangkat lunak Smartlmage Lite
akan menyesuaikan kecerahan, kontras, warmna,
serta ketajaman secara real time dan dinamis
untuk menyempurnakan pengalaman tampilan
monitor Anda.

EJ Bagaimana prosedurnya?

Smartimage Lite merupakan teknologi eksklusif
dan canggih dari Philips yang menganalisis konten
yang ditampilkan di layar. Berdasarkan skenario
yang dipilih, Smartlmage Lite menyempurnakan
kontras, saturasi warna, dan ketajaman gambar
secara dinamis untuk menyempurnakan konten
yang sedang ditampilkan. Semua dapat dilakukan
secara real time dengan menekan satu tombol.

] Bagaimana cara mengaktifkan Smartimage
Lite?

1. Tekan BD untuk mengaktifkan Smartlmage
Lite di layar;
2. Tekan terus B untuk beralih di antara

10

Standard (Standar), Internet, dan Game
(Permainan).

3. Tampilan Smartlmage Lite akan tetap
muncul di layar selama 5 detik atau
Anda juga dapat menekan “OK" untuk
mengkonfirmasi.

4. Bila Smartimage Lite diaktifkan, skema
sRGB akan dinonaktifkan secara otomatis.
Untuk menggunakan sRGB, Anda harus
menonaktifkan Smartimage Lite dengan
tombol B di bezel depan monitor.

Selain menggunakan tombol B untuk menggulir
ke bawah, Anda juga dapat menekan tombol

v A untuk memilih, lalu menekan “OK" untuk
mengkonfirmasi pilihan dan menutup OSD
Smartlmage Lite.

Ada tiga mode yang dapat dipilih: Standard
(Standar), Internet, dan Game (Permainan).

@ SmartImage '™

Standard

Internet

» Standard (Standar): Menyempurnakan
teks dan mengurangi kecerahan untuk
meningkatkan kemampuan baca serta
mengurangi kelelahan pada mata. Mode
ini secara nyata akan menyempurnakan
kemampuan baca dan produktivitas saat
Anda bekerja dengan spreadsheet, file PDF,
artikel yang dipindai, atau aplikasi kantor
umum lainnya.

* Internet: Profil ini menggabungkan saturasi
warna, kontras dinamis, dan penyempurnaan
ketajaman untuk menampilkan foto dan
gambar lain dengan kejemihan yang luar
biasa dalam warna yang menarik. Semua
dilakukan tanpa memerlukan alat bantu lain
dan tanpa adanya wama yang pudar.

*  Game (Permainan): Mengaktifkan sirkuit
drive untuk waktu respons terbaik,
menghilangkan tepi bergerigi untuk
objek yang bergerak cepat di layar, serta
meningkatkan rasio kontras untuk skema
terang dan gelap. Profil ini memberikan
pengalaman terbaik bagi penggemar
permainan dalam menjalankan permainan.




3.2 SmartContrast

El Apakah yang dimaksud dengan
SmartContrast?
Teknologi unik yang secara dinamis menganalisis
konten yang ditampilkan serta secara otomatis
mengoptimalkan rasio kontras monitor LCD
untuk kejerihan visual dan kenyamanan
tampilan maksimal dengan menambah cahaya
lampu latar agar gambar lebih jernih, tajam,
dan terang, atau mengurangi cahaya lampu
latar untuk tampilan gambar yang jelas di latar
belakang gelap.

El Mengapa saya memerlukannya?

Anda menginginkan kejernihan visual dan
kenyamanan tampilan terbaik untuk setiap
jenis konten. SmartContrast secara dinamis
mengontrol kontras dan menyesuaikan cahaya
lampu latar agar gambar dalam permainan
serta video lebih jernih, tajam, dan terang, atau
menampilkan teks yang jelas dan mudah dibaca
untuk pekerjaan kantor. Dengan mengurangi
pemakaian daya monitor, Anda menghemat
biaya untuk daya dan memperpanjang masa
pakai monitor.

El Bagaimana prosedurnya’

Saat diaktifkan, SmartContrast akan menganalisis
konten yang ditampilkan secara real time

untuk menyesuaikan warna dan mengontrol
intensitas cahaya lampu latar. Fungsi ini akan
secara dinamis menyempurnakan kontras

untuk pengalaman hiburan yang luar biasa saat
menonton video atau menjalankan permainan.

3.3 Philips SmartControl Lite

Perangkat lunak SmartControl Lite baru dari
Phillips memungkinkan Anda mengontrol
monitor melalui antarmuka grafis layar

yang mudah digunakan. Penyesuaian rumit
sebelumnya kini tidak ada lagi karena panduan
perangkat lunak yang mudah digunakan ini
akan memandu Anda menyesuaikan resolusi
penyempurnaan, Kalibrasi warna, Pengaturan
jam/fase, Pengaturan titik putih RGB, dsb.
Dengan dilengkapi teknologi algoritme inti
terbaru untuk pemrosesan serta respons yang
cepat, perangkat lunak berbasis lkon animasi
yang menarik dan mendukung Windows 7

ini siap menyempurnakan pengalaman Anda
menggunakan monitor Philips!
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El Penginstalan
lkuti petunjuk dan selesaikan penginstalan.

Anda dapat mengaktifkannya setelah
penginstalan selesai.

Jika ingin mengaktifkannya di lain waktu, Anda
dapat mengklik cara pintas di desktop atau
toolbar.

PHILIPS et phita cromiicorr

Wizard pengaktifan pertama kali

*  Setelah penginstalan SmartControl Lite
selesai, Wizard pengaktifan pertama kali
akan terbuka secara otomatis.

*  Wizard ini akan memandu Anda
menyesuaikan performa monitor secara
bertahap.

*  Menu Plug-in juga dapat dibuka untuk
menjalankan wizard di lain waktu.

* Anda dapat menyesuaikan pilihan lainnya
tanpa menggunakan wizard melalui panel
Standard (Standar).

[ e 750 nootal) Jix

PHILIPS

SmartControl Lite

Wizard

88
2 iai




3. Pengoptimalan Gambar

E1 Memulai dengan panel Standard (Standar):

Menu Adjust (Penyesuaian):

*  Menu Adjust (Penyesuaian) digunakan
untuk menyesuaikan Brightness (Kecerahan),
Contrast (Kontras), Focus (Fokus), Position
(Posisi), dan Resolution (Resolusi).

* Anda dapat mengikuti petunjuk dan
melakukan penyesuaian.

*  Cancel (Batal) mengkonfirmasi pengguna
jika ingin membatalkan penginstalan.

[ e—

SmartControl Lite

giad

[ e—

SmartControl Lite

gad
9

Oxsions

+

Brighiness

3 - Poden 32501 (esLso000m1) (%

PHILIPS
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SmartControl Lite

[ e—

SmartControl Lite
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i
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[ e

SmartControl Lite

3. o z3m (cxrrsensont) ()8

PHILIPS

Focus

unss aeta s
—t ont) (it

PHILIPS

Position
i 1 POSRIGN DTS 10 CHVURS S TR

Pt 22531 (et isoneont) (T

PHILIPS

Resolution




3. Pengoptimalan Gambar
Menu Color (Warna):

Menu Color (Warna) digunakan untuk
menyesuaikan RGB, Black Level (Tingkat
Hitam), White Point (Titik Putih), Color
Calibration (Kalibrasi Warna), dan
Smartlmage Lite (Lihat bagian Smartlmage
Lite).

Anda dapat mengikuti petunjuk dan
melakukan penyesuaian.

Untuk item submenu berdasarkan input
Anda, lihat tabel di bawah ini.

Misalnya Color Calibration (Kalibrasi
Warna).

W St 2- i 22381 (a1 se00n) ()X

SmartControl Lite PHILIPS

Black Level

Bk Loved 4

i ek Livwsd

Akt u

[ P 3 ot 11 (es3eL5000001) () X

SmartControl Lite PHILIPS

White Point
Wiite Pont

= o
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B e 3o 7350 (oris0080nt) X
SmartControl Lite PHILIPS

Display Gamma

&
= !
e e
o f |

L 24 -
LE.-
et

yer— 3 - 22001 e sossont) (T
PHILIPS

SmartControl Lite

Calibration

- ’
=
.
. -

"Show Me" (Tunjukkan) memulai tutorial
kalibrasi warna.

Start (Mulai) - memulai urutan kalibrasi
warna 6 langkah.

Quick View (Tampilan Ringkas) memuat
gambar sebelum/sesudah kalibrasi.

Untuk kembali ke panel awal Color
(Warna), klik tombol Cancel (Batal).
Enable color calibration (Aktifkan kalibrasi
warna) - telah diaktifkan secara default.
Jika tidak dicentang, kalibrasi warna tidak
dapat dijalankan serta tombol start (mulai)
dan quick view (tampilan ringkas) akan
dinonaktifkan.

Info paten harus ditampilkan di layar
kalibrasi.



3. Pengoptimalan Gambar

Layar Kalibrasi warna pertama:

*  Tombol Previous (Sebelumnya)
dinonaktifkan hingga layar kalibrasi warna
kedua ditampilkan.

*  Next (Berikutnya) menampilkan layar sesuai
urutan selanjutnya (6 target).

* Layar terakhir menampilkan panel
File>Presets (File>Preset).

» Cancel (Batal) menutup antarmuka
pengguna dan kembali ke halaman plug in.

Smartlmage Lite
Memungkinkan pengguna mengubah pengaturan
layar menjadi lebih baik berdasarkan konten.

Bila Entertainment (Hiburan) ditetapkan,
SmartContrast dan SmartResponse akan
diaktifkan.

[ et L&

SmartControl Lite PHILIPS

SmartImage

O Caltyten
\g .;;'@.C =
Garw
-
° .Y
Intermet Sandae

Options>Preferences (Pilihan>Preferensi) -
Hanya diaktifkan sewaktu memilih Preferences
(Preferensi) dari menu drop-down Options
(Pilihan). Di layar yang tidak didukung, namun
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dilengkapi DDC/CI, hanya tab Help (Bantuan)
dan Options (Pilihan) yang tersedia.
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SmartControl Lite PHILIPS

Preferences.

*  Menampilkan pengaturan preferensi saat ini.

* Jika kotak dicentang, fitur akan diaktifkan.
Kotak centang berfungsi sebagai pengunci.

* Enable Context Menu (Aktifkan Menu
Konteks) di desktop dicentang (Aktif)
secara default. Enable Context Menu
(Aktifkan Menu Konteks) menampilkan
pilihan Select Preset (Pilih Preset) dan
Tune Display (Sempurnakan Layar) untuk
SmartControl Lite dalam menu konteks klik
kanan di desktop. Disabled (Dinonaktifkan)
menghapus SmartControl Lite dari menu
konteks klik kanan tersebut.

» lkon Enable Task Tray (Aktifkan Baki Tugas)
dicentang (Aktif) secara default. Aktifkan
menu konteks menampilkan menu baki
tugas untuk SmartControl Lite. Mengklik
kanan ikon baki tugas akan menampilkan
pilihan menu Help (Bantuan), Technical
Support (Dukungan Teknis), Check for
Update (Periksa Pembaruan), About
(Tentang), dan Exit (Keluar). Bila Enable
task tray menu (Aktifkan menu baki tugas)
dinonaktifkan, ikon baki tugas hanya akan
menampilkan EXIT (KELUAR).

* Run at Startup (Jalankan Saat Pengaktifan)
dicentang (Aktif) secara default. Bila
dinonaktifkan, SmartControl Lite tidak akan
berjalan saat pengaktifan atau tidak akan



3. Pengoptimalan Gambar

ditampilkan dalam baki tugas. Satu-satunya
cara menjalankan SmartControl Lite
adalah melalui cara pintas desktop atau file
program. Preset apapun yang ditetapkan
untuk berjalan saat pengaktifan tidak

akan dimuat bila kotak ini tidak dicentang
(Dinonaktifkan).

* Enable transparency mode (Aktifkan mode
transparansi) (Windows 7, Vista, XP). Nilai
default adalah 0% Tidak Tembus Cahaya.

Options>Input (Pilihan>Input) - Hanya
diaktifkan sewaktu memilih Input dari menu
drop-down Options (Pilihan). Di layar yang tidak
didukung, namun dilengkapi DDC/CI, hanya

tab Help (Bantuan) dan Options (Pilihan) yang
tersedia. Semua tab SmartControl Lite lainnya

tidak tersedia.
SmartControl Lite PHILIPS

Input

EPORTANT!

‘! i iw {‘ TR

Arsiog in

*  Menampilkan panel petunjuk Source
(Sumber) dan pengaturan sumber input
saat ini.

* Dilayar input tunggal, panel ini tidak akan
ditampilkan.

Options>Audio (Pilihan>Audio) - Hanya
diaktifkan sewaktu memilih Audio dari menu
drop-down Options (Pilihan).

Di layar yang tidak didukung, namun dilengkapi
DDC/CI, hanya tab Help (Bantuan) dan Options
(Pilihan) yang tersedia.
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Help>User Manual (Bantuan>Panduan
Pengguna) - Hanya diaktifkan sewaktu memilih
User Manual (Panduan Pengguna) dari menu
drop-down Help (Bantuan). Di layar yang tidak
didukung, namun dilengkapi DDC/CI, hanya
tab Help (Bantuan) dan Options (Pilihan) yang
tersedia.

B smarceren e ix
PHILIPS

SmartControl Lite

Help>Version (Bantuan>Versi) - Hanya
diaktifkan sewaktu memilih Version (Versi) dari
menu drop- down Help (Bantuan). Di layar
yang tidak didukung, namun dilengkapi DDC/CI,
hanya tab Help (Bantuan) dan Options (Pilihan)
yang tersedia.
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SmartControl Lite

Version

Menu Sesuai Konteks

Context Sensitive Menu (Menu Sesuali
Konteks) diaktifkan secara default. Jika Enable
Context Menu (Aktifkan Menu Konteks) telah
dicentang dalam panel Options>Preferences
(Pilihan>Preferensi), menu tersebut akan
ditampilkan.

g SmartControl
Belect Presst »
une Display

Menu Konteks memiliki empat entri:

* SmartControl Lite - Bila dipilih, About
Screen (Tentang Layar) akan ditampilkan.

*  Select Preset (Pilih Preset) - Memberikan
urutan menu preset yang disimpan untuk
digunakan di lain waktu. Tanda centang
menunjukkan preset yang saat ini dipilih.
Preset Pabrik juga dapat dipilih dari menu
drop down.

» Tune Display (Sempurnakan Layar) -
Membuka panel kontrol SmartControl Lite.

*  Smartlmage Lite - Memeriksa pengaturan
saat ini, seperti Standard (Standar), Intemnet,
dan Game (Permainan).

Menu Baki Tugas Diaktifkan

Menu baki tugas dapat ditampilkan dengan
mengklik kanan ikon SmartControl Lite dari baki
tugas. Klik kiri akan mengaktifkan aplikasi.
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Help

Technical Support
Check for Update
About

Exik

Baki tugas memiliki lima entri:

*  Help (Bantuan) - Mengakses file User
Manual (Panduan Pengguna): Buka file User
Manual (Panduan Pengguna) menggunakan
jendela browser default.

*  Technical Support (Dukungan Teknis) -
Menampilkan halaman dukungan teknis.

*  Check for Update (Periksa Pembaruan) -
Mengarahkan pengguna ke Arahan PDI dan
memeriksa versi pengguna terhadap versi
terbaru yang tersedia.

* About (Tentang) - Menampilkan informasi
rinci tentang referensi: versi produk,
informasi edisi, dan nama produk.

*  Exit (Keluar) - Menutup SmartControl Lite.

Untuk kembali menjalankan SmartControl Lite,
pilih SmartControl Lite dari menu Program, lalu
klik dua kali ikon PC desktop, atau hidupkan
ulang sistem.

PHILIPS
SmartControl

‘dtune-standard S2007-01-04-151.23
Copyright 19932007 Portrat Displays, Inc.
Fazsere fanang

Menu Baki Tugas Dinonaktifkan

Bila Baki Tugas dinonaktifkan dalam folder
preferensi, maka hanya pilihan EXIT (KELUAR)
yang tersedia. Untuk menghapus SmartControl
Lite secara keseluruhan dari baki tugas,
nonaktifkan Run at Startup (Jalankan Saat
Pengaktifan) dalam Options>Preferences
(Pilihan>Preferensi).



4. PowerSensor™

(Hanya tersedia untuk model 227E3LPH)

PowerSensor adalah teknologi ramah lingkungan yang unik dari Philips yang memungkinkan pengguna
menghemat penggunaan daya hingga 80%. Sejalan dengan drive Sense and Simplicity Philip, teknologi
yang praktis ini dapat digunakan seketika tanpa pemasangan perangkat keras atau penginstalan perangkat
lunak, dan tanpa intevensi pengguna dalam mode default.

1] Bagaimana prosedurnya?

* PowerSensor berfungsi berdasarkan prinsip transmisi dan penerimaan sinyal “inframerah” yang tidak
berbahaya agar dapat mendeteksi keberadaan pengguna.

* Bila pengguna berada di depan monitor, maka monitor akan beroperasi secara normal pada
pengaturan yang telah ditentukan pengguna, misalnya kecerahan, kontras, warna, dll.

*  Misalnya, bila monitor ditetapkan pada kecerahan 100%, lalu pengguna meninggalkan kursinya dan
tidak lagi berada di depan monitor; maka monitor akan secara otomatis mengurangi penggunaan
daya hingga menjadi 80%.

Pengguna ada di depan Pengguna tidak ada

Penggunaan daya sebagaimana ditunjukkan di atas hanya ditujukan sebagai acuan

Pengaturan

Pengaturan default

Pada pengaturan default, (Pengaturan 3), PowerSensor dirancang untuk mendeteksi keberadaan
pengguna yang berlokasi antara 90 hingga 110 cm (35,4 hingga 43.3 inci) dari layar dan dalam 5 derajat
di kiri maupun kanan monitor.

Pengaturan kustom

* Jika Anda ingin berada pada posisi di luar perimeter yang tercantum di atas, pilih kekuatan sinyal
yang lebih tinggi untuk efisiensi deteksi yang optimal: Semakin tinggi pengaturan, maka akan semakin
kuat sinyal deteksi. Untuk efisiensi dan deteksi tepat yang maksimum pada PowerSensor, posisikan
diri Anda tepat di depan monitor.

* Jika Anda memilih untuk berada lebih dari 110 cm atau 43,3 inci dari monitor, gunakan sinyal
deteksi maksimum untuk jarak hingga 130 cm atau 51,2 inci. (Pengaturan 4)

* Karena pakaian berwarna gelap tertentu cenderung menyerap sinyal inframerah meskipun
pengguna berada 100 cm atau 40 inci dari layar, tingkatkan kekuatan sinyal bila mengenakan
pakaian hitam atau berwarna gelap lainnya.

* Anda dapat setiap saat kembali ke mode default (Pengaturan 3).
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4. PowerSensor

Tombol pintas Jarak sensor

H cara menyesuaikan pengaturan

Jika PowerSensor tidak beroperasi dengan benar di dalam maupun luar kisaran default, berikut
adalah cara menyetel deteksi:

* Tekan tombol pintas PowerSensor:
* Anda akan menemukan posisi default ‘3’ pada panel penyesuaian.
* Atur penyesuaian deteksi PowerSensor ke (Pengaturan 4), lalu tekan OK.

* Uji konfigurasi baru ini untuk mengetahui apakah PowerSensor mendeteksi posisi Anda saat itu
dengan baik.

6 Catatan

Mode PowerSensor yang dipilih secara manual akan tetap dioperasikan, kecuali jika dan hingga
disesuaikan ulang atau mode default digunakan. Jika Anda menyadari bahwa sensitivitas PowerSensor
terlalu tinggi terhadap gerakan sekitar karena alasan tertentu, atur ke kekuatan sinyal yang lebih rendah.
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5. Spesifikasi Teknis

Jenis panel LCD LCD TFT

Lampu latar LED

Ukuran panel 21,5" (54,6 cm)
Rasio aspek 16:9

Jarak Piksel 0,248 x 0,248 mm
Kecerahan 250 cd/m?
SmartContrast 20,000,000:1

Rasio kontras (biasa) 1000:1

Waktu respons (biasa) 5 ms

Resolusi Optimum 1920x1080 @ 60Hz

Input sinyal

Sudut pandang 170° (H)/160° (V) @C/R>10
Penyempurnaan Gambar Smartimage Lite

Warna layar 16,7 M

Kecepatan refresh vertikal 56Hz - 76Hz

Frekuensi Horizontal 30kHz - 83kHz

sRGB YA

DVI-D (digital), VGA (Analog)
HDMI (tersedia untuk model 227E3LH, 227E3LPH)

Kenyamanan Pengguna

Sinyal Input Sinkronisasi Terpisah, Sinkronisasi pada Nyala Hijau

227E3L:  ®@/v /A /< /0K 0)
227E3LH:  Ep/v ©/A 1q/4 /0K 0
227E3LPH: &p/v ©/A SENSOR/« /0K )

Bahasa OSD

Inggris, Prancis, Jerman, Italia, Rusia, Spanyol, China Modern, Portugis,
Turki

Kenyamanan lainnya

Kunci Kensington

Kompatibilitas Plug & Play

Kemiringan

DDC/CI, sRGB, Windows 7/Vista/XP, Mac OSX, Linux

-5/+20

Mode Aktif

227E3L: 21,8W (standar)
227E3LH:  21,8W (standar), 27W (maks.)
227E3LPH: 21,8W (standar), 24W (maks.)

Pemakaian Daya
(Metode pengujian

Tegangan Input AC
pada 100VAC +/-

Tegangan Input AC
pada 115VAC +/-

Tegangan Input AC
pada 230VAC +/-

EnergyStar 5.0) S5VAC, 50Hz +/- 3Hz | 5VAC, 60Hz +/- 3Hz | 5VAC, 50Hz +/- 3Hz
Pgngoperasmn Normal 184W 184W 185W

(biasa)

Tidur (Siaga) 0,5W 05W 0,5W

Tidak Aktif 05W 05W 05W
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Penghilangan Panas*

Tegangan Input AC
pada 100VAC +/-
5VAC, 50Hz +/- 3Hz

Tegangan Input AC
pada 115VAC +/-
5VAC, 60Hz +/- 3Hz

Tegangan Input AC
pada 230VAC +/-
5VAC, 50Hz +/- 3Hz

Pengoperasian Normal 62,8 BTU/jam 62,8 BTU/jam 63,14 BTU/jam
Tidur (Siaga) 1,71 BTU/jam 1,71 BTU/jam 1,71 BTU/jam
Tidak Aktif 1,71 BTU/jam 1,71 BTU/jam 1,71 BTU/jam
Indikator LED Daya Mode Aktif: Putih, Siaga/Tidur: Putih (Berkedip)

Catu Daya Efek terbakar, 100-240VAC, 50-60Hz

Produk dengan dudukan
(PxLxT)

534,34 x 4079 x 216 mm

Produk tanpa dudukan
(PxLxT)

534,34 x 335,89 x 41,1 mm

Produk dengan dudukan 4,01kg
Produk tanpa dudukan 347kg
Produk dengan kemasan 417kg
Kisaran suhu (beroperasi) 0°C hingga 40°C

Kisaran suhu (tidak
beroperasi)

-20°C hingga 60°C

Kelembaban relatif

20% hingga 80%

beroperasi: + 12.000 kaki (3.658 m)

Pengesahan Peraturan

Ketinggian tidak beroperasi: + 40.000 kaki (12.192 m)
MTBF 30.000 jam

ROHS YA

EPEAT Silver (www.epeat.net)

Kemasan 100% dapat didaur ulang

Penandaan CE, FCC Kelas B, GOST, SEMKO, Bersertifikasi TCO,
UL/cUL, BSMI, 1ISO9241-307

Warna Hitam (Belakang), Biru (Depan)
Lapisan Luar Mengkilap
© Catatan

1. EPEAT Gold atau Silver hanya berlaku di lokasi tempat produk Philips terdaftar Untuk status
registrasi di negara Anda, kunjungi www. epeat.net.

2. Informasi ini dapat berubah tanpa pemberitahuan sebelumnya. Untuk men-download selebaran
versi terbaru, kunjungi www.philips.com/support.
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. Spesifikasi Teknis

5.1 Mode Resolusi & Preset

Bl Resolusi Maksimum
1920 x 1080 pada 60 Hz (input analog)
1920 x 1080 pada 60 Hz (input digital)

B3 Resolusi yang Disarankan
1920 x 1080 pada 60 Hz (input digital)

[Format]_Resolusi jens[Frek V. ) ]
480i 720 x480 | SD |60

480p 720 x480 | SD |60

576i 720 x576 | SD |50

576p 720 x 576 | SD |50

720p | 1280x720 | HD |50, 60

1080i | 1920 x 1080 | HD |50, 60

1080p | 1920 x 1080 | HD (24, 25, 30, 50, 60

& Catatan

Perlu diketahui bahwa layar Anda akan berfungsi
sempurna dengan resolusi asli 1920 X 1080
pada 60Hz. Untuk mendapatkan kualitas
tampilan sempurna, ikuti saran resolusi ini.
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6. Manajemen Daya

6. Manajemen Daya

Jika PC dilengkapi perangkat lunak yang

terinstal atau kartu tampilan yang terpasang
sesuai dengan DPM VESA, monitor secara
otomatis dapat mengurangi pemakaian daya
saat tidak digunakan. Jika terdapat input dari
keyboard, mouse, atau perangkat input lainnya
yang terdeteksi, monitor akan 'bangun' secara
otomatis. Tabel berikut menunjukkan pemakaian
daya dan pemberian sinyal dari fitur hemat daya
otomatis ini:

Mode Video Sinkronisasi | Sinkronisasi| Daya yang Warna
VESA horizontal | vertikal Digunakan LED
Akt | AKTIF | Ya Ya SUBW by
(biasa)
y TIDAK " . <05 W Putih
Tidur AKTIF Tidak Tidak ) (berkedip)
Matikan TIDAK <05W TIDAK
AN AKTIF - - (biasa) AKTIF

Berikut adalah konfigurasi yang digunakan untuk
menghitung pemakaian daya pada monitor.

e Resolusi asli: 1920 x 1080

e Kontras: 50%

e Kecerahan: 250 nit

»  Suhu warna: 6.500k dengan pola putih
sepenuhnya

€ Catatan

Informasi ini dapat berubah tanpa

pemberitahuan sebelumnya.
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7. Informasi Peraturan

Lead-free Product

Lead free display promotes
environmentally sound recovery
and disposal of waste from electrical
and electronic equipment. Toxic
substances like Lead has been eliminated

and compliance with European community's
stringent RoHs directive mandating restrictions
on hazardous substances in electrical and
electronic equipment have been adhered to

in order to make Philips monitors safe to use
throughout its life cycle.

Congratulations!

This display is designed for both you and the
planet

The display you have just purchased
carries the TCO Certified label.

This ensures that your display is
designed, manufactured and tested according to
some of the strictest quality and environmental
requirements in the world. This makes for a
high performance product, designed with the
user in focus that also minimizes the impact on
the climate and our natural environment.

TCO Certified is a third party verified program,
where every product model is tested by an
accredited impartial test laboratory. TCO
Certified represents one of the toughest
certifications for displays worldwide.

Some of the Usability features of the TCO
Certified for displays:

* Visual ergonomics for good image quality
is tested to ensure top performance and
reduce sight and strain problems. Important
parameters are luminance, contrast,
resolution, black level, gamma curve, colour
and luminance uniformity and colour
rendering.

*  Products are tested according to rigorous
safety standards at impartial laboratories.

* Electric and magnetic fields emissions as
low as normal household background
levels.

* Low acoustic noise emissions (when
applicable).

Some of the Environmental features of the
TCO Certified for displays:

*  The brand owner demonstrates corporate
social responsibility and has a certified
environmental management system (EMAS
or 1SO 14001).

*  Very low energy consumption both in on-
and standby mode minimize climate impact.

* Restrictions on chlorinated and brominated
flame retardants, plasticizers, plastics and
heavy metals such as cadmium, mercury
and lead (RoHS compliance).

* Both product and product packaging is
prepared for recycling.

* The brand owner offers take-back options.

The requirements can be downloaded from our
web site. The requirements included in this label
have been developed by TCO Development

in co-operation with scientists, experts, users as
well as manufacturers all over the world. Since
the end of the 1980s TCO has been involved

in influencing the development of IT equipment
in a more user-friendly direction. Our labeling
system started with displays in 1992 and is

now requested by users and [T-manufacturers
all over the world. About 50% of all displays
worldwide are TCO certified.

For more information, please visit:
www.tcodevelopment.com

TCOF1058 TCO Document, Ver. 2.1

I[n Technology for you and the planet
CERTIFIED



EPEAT
(www.epeat.net)

“The EPEAT (Electronic Product
@ Environmental Assessment Tool)

program evaluates computer

desktops, laptops, and monitors
based on 571 environmental criteria developed
through an extensive stakeholder consensus
process supported by US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and
select desktop computers, notebooks and
monitors based on their environmental
attributes. EPEAT also provides a clear and
consistent set of performance criteria for the
design of products, and provides an opportunity
for manufacturers to secure market recognition
for efforts to reduce the environmental impact
of its products.”

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT'S
requirement that all registered products meet
ENERGY STAR'’s energy efficiency specifications,
means that these products will consume less
energy throughout their life.
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CE Declaration of Conformity

This product is in conformity with the following
standards

* EN60950-1:2006 (Safety requirement of
Information Technology Equipment).

»  EN55022:2006 (Radio Disturbance
requirement of Information Technology
Equipment).

*  EN55024:1998+A1:2001+A2:2003
(Immunity requirement of Information
Technology Equipment).

*  EN61000-3-2:2006 (Limits for Harmonic
Current Emission).

e EN61000-3-3:1995+A1:2001+A2:2005
(Limitation of Voltage Fluctuation and
Flicker) following provisions of directives
applicable.

* 2006/95/EC (Low Voltage Directive).

»  2004/108/EC (EMC Directive).

» 2005/32/EC (EuP Directive, EC No.
1275/2008 mplementing Directive
for Standby and Off mode power
consumption) and is produced by a
manufacturing organization on 1SO9000
level.

The product also comply with the following

standards

* 15S09241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

»  GS EK1-2000:2009 (GS mark requirement).

»  prEN50279:1998 (Low Frequency Electric
and Magnetic fields for Visual Display).

e MPR-II (MPR:1990:8/1990:10 Low
Frequency Electric and Magnetic fields).

*  TCO CERTIFIED (Requirement for
Environment Labeling of Ergonomics,
Energy, Ecology and Emission, TCO: Swedish
Confederation of Professional Employees)
for TCO versions.



Energy Star Declaration

(www.energystar.gov)

As an ENERGY STAR® Partner, we
have determined that this product

meets the ENERGY STAR®
guidelines for energy efficiency.

i)

& Note

We recommend you switch off the monitor
when it is not in use for a long time.

Federal Communications Commission (FCC)
Notice (U.S. Only)

€ This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.
This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turning the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

»  Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

»  Consult the dealer or an experienced
radio/TV technician for help.
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@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following
two conditions: (1) this device may not cause
harmful interference, and (2) this device must
accept any interference received, including
interference that may cause undesired
operation.

Commission Federale de la Communication
(FCC Declaration)

© Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numériques de class B,aux termes de l'article
15 Des regles de la FCC. Ces limites sont
congues de facon a fourir une protection
raisonnable contre les interférences nuisibles
dans le cadre d'une installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences
nuisibles aux communications radio.



Cependant, rien ne peut garantir |'absence
d'interférences dans le cadre d'une
installation particuliere. Si cet appareil est
la cause d'interférences nuisibles pour

la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en
fermant I'équipement, puis en le remettant
en fonction, I'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

* Réorienter ou déplacer I'antenne de
réception.

* Augmenter la distance entre I'équipement
et le récepteur.

* Brancher '€quipement sur un autre circuit
que celui utilisé par le récepteur.

e Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

Toutes modifications n'ayant pas recu
I'approbation des services compétents

en matiere de conformité est susceptible
d'interdire a I'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTE TOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.
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EN 55022 Compliance (Czech Republic Only)

This dswice belongs to category B devices as described in EN 55022, unless it is specifi-
cally stated that it i a Class A devics on the epeciication labal. The following apglies to
devices in Class A of EN 55022 (radius of protection up to 30 metars). The user of the
davics is obliged to take all stapa necessary o remove sources of interfsrence io tela-
communication or other devicas.

Pokud neni na typovém Stitku po&itade uvedeno, 28 spadé dodo tfidy A podie EN 55022,

do ffidy B podie EN 55022, Pro zafizeni zefazend do tdy A (chranné
pésma 30m) podie EN B5022 plati nésledujicl. Dojde-li k ruien! telekomunikadnich nebo
Jinjch zafizeni je utivatal povinnen provést takovd opatfgnl, by neeni odstranil,

Polish Center for Testing and Certification
Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer, and so
on) should have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/
T-42107 and PN-89/E-06251.

Wymagania Polskiego Centrum Badan i Certyfikacji

Urzleenie powinno byt sasibane ¢ pnigada 2 preylaczonym obwodem ochronmyo (gnigedo @
kolkiem). Wapdlpracuface 2¢ sobg urzsdzenia (kompuser, monitor, druksrka) powiniy byé zsilane
2 g0 samepo dridla.

Instalicja elektrycana pomieseczenta powinna smwierad w pruewoizie Euzowym rezeowows achrang
proed swazciami, w postaci bezpsecenika o wartobel mamionawe] nie wickszej nik 16A (amperiw).
W el catkowitego wybserenia urzadzenia 2 sieet zasilania, nalezy wyjné wivceks kabla
easilajacepo # pmardka, kudre powinno enjdowad sig w poblizy ursadzenda @ by it dostepne.

Faak beaplecaefsrwa "B” potwicrdzs zpodnodd urzsdzenia 2 wynspaniani hezplecsehstu
weytkowania awartymi w PN-SRT4207 § PR-89E06251.

Pozostale instrukcje begpieczensiwa

* Mg maleiy uiywad wiyceek adaptercwych lub usuwal kolka abwodu ochromnego « wiyeek,
Jekeli koseezne jost uikyewe peredhuzaces to naledy wiyt preedubace S-rylowego 2
i deen ol

System v maleiy caberpieceyd proed nagtymi, chwilowymi

kami napigcia, wiywijas eliminators praspics, urzdeenia dopasawijie

bezzakiicenivweia oz zasilania

5 e eEalo na kablach systeenu kompulerowegi. oraz aby kable nie
3¢ iednn byboby i e nadeptywad e porykal sl o e,

innych phyndw na system komputerowy.

erostami bub spad-
uh

najdowad sig 2 dals od g

Tacyjnych. Nakezy un
karmpuler oriz umisszczanss kamputera w ciasmym migse bez mailiwobe eyrkalacyi pooi-
etz wokdl niego.




North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS,

Placering/Ventilation

ADVARSEL:

SORG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SIJOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR

ST@MTILF@RSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)
RAZEARERIIBE |

Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schiden durch Réntgenstrahlen” festgelegten
Vorschriften.

Auf der Rickwand des Gerdtes befindet sich
ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Stérstrahlern nach Anlage
a5 Abs. 4 der Réntgenverordnung erfilit
sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, dal3

1. Reparaturen nur durch Fachpersonal
durchgefihrt werden.
2. nur original-Ersatzteile verwendet werden.

bei Ersatz der Bildréhre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Grinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf
dunklem Untergrund zu verwenden (schlechte
Lesbarkeit und erhdhte Augenbelastung bei zu
geringem Zeichenkontrast waren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betrdgt 70dB (A) oder
weniger.

) ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUB LEICHT
ZUGANGLICH SIND.



China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products including CRT and Monitor
which are produced and sold for China market
have to meet China RoHS request.
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8. Layanan pelanggan dan
jaminan

8.1 Kebijakan Cacat Piksel Monitor
Panel Datar Philips

Philips berupaya memberikan produk berkualitas
tertinggi. Kami menggunakan beberapa proses
produksi tercanggih di industri dan menerapkan
kontrol kualitas yang ketat. Namun, cacat piksel
atau subpiksel pada panel LCD TFT yang
digunakan di monitor panel datar terkadang
tidak dapat dihindari. Tidak ada produsen yang
dapat menjamin semua panel akan bebas dari
cacat piksel, namun Philips menjamin bahwa
setiap monitor dengan jumlah cacat yang tidak
dapat diterima akan diperbaiki atau diganti sesuai
dengan jaminan yang berlaku. Pemberitahuan

ini menjelaskan berbagai jenis cacat piksel dan
menentukan tingkat cacat yang dapat diterima
untuk masing-masing jenis tersebut. Untuk
memenuhi syarat dalam mendapatkan perbaikan
atau penggantian sesuai jaminan, jumlah cacat
piksel pada panel LCD TFT harus melampaui
tingkat yang dapat diterima. Misalnya, jumlah
cacat subpiksel pada monitor tidak boleh

lebih dari 0,0004%. Philips bahkan selanjutnya
menentukan standar kualitas lebih tinggi untuk
jenis atau kombinasi cacat piksel tertentu yang
lebih nyata dibandingkan dengan yang lainnya.
Kebijakan ini berlaku secara global.

Subpiksel Subpiksel

ooy
G R G B
piksel

Piksel dan Subpiksel

Piksel, atau elemen gambar; terdiri dari tiga
subpiksel dalam warna utama merah, hijau,
dan biru. Kombinasi beberapa piksel akan
membentuk gambar: Bila semua subpiksel pada
piksel menyala, kombinasi ketiga subpiksel
berwarna tersebut akan muncul sebagai satu
piksel putih. Bila semua mati, kombinasi ketiga

Subpiksel
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subpiksel berwarna akan muncul sebagai satu
piksel hitam. Kombinasi lainnya dari subpiksel
yang menyala dan mati akan muncul sebagai satu
piksel warna lain.

Jenis Cacat Piksel

Cacat piksel dan subpiksel muncul di layar dalam
berbagai bentuk. Ada dua kategori cacat piksel
dan masing-masing kategori tersebut terdiri dari
beberapa jenis cacat subpiksel.

Cacat Titik Terang

Cacat titik terang muncul sebagai piksel maupun
subpiksel yang selalu terang atau 'menyala’.
Karenanya, titik terang merupakan subpiksel yang
terlihat jelas di layar bila monitor menampilkan
pola gelap. Berikut adalah jenis cacat titik terang:

Satu subpiksel merah, hijau, atau biru terang

I C

Dua subpiksel terang yang berdekatan:
Merah + Biru = Ungu

- Merah + Hijau = Kuning

- Hijau + Biru = Cyan (Biru Muda)

Tiga subpiksel terang yang berdekatan (satu
piksel putih)



€ Catatan

Titik terang merah atau biru harus lebih dari 50
persen lebih terang daripada titik di sekitarnya,
sedangkan titik terang hijau 30 persen lebih
terang daripada titik di sekitarnya.

Cacat Titik Gelap

Cacat titik gelap muncul sebagai piksel maupun
subpiksel yang selalu gelap atau 'mati'. Karenanya,
titik gelap merupakan subpiksel yang terlihat
jelas di layar bila monitor menampilkan pola
terang. Berikut adalah jenis cacat titik gelap:

Jarak Cacat Piksel

Karena cacat piksel dan subpiksel sejenis yang
saling berdekatan mungkin terlihat lebih nyata,
Philips juga menentukan toleransi untuk jarak
cacat piksel.

Toleransi Cacat Piksel

Untuk memenuhi syarat dalam mendapatkan
perbaikan atau penggantian karena cacat piksel
selama masa berlaku jaminan, panel LCD TFT
pada monitor panel datar Philips harus memiliki
cacat piksel maupun subpiksel melebihi toleransi
yang tercantum dalam tabel berikut ini.

CACAT TITIK TERANG TINGKAT YANG DAPAT DITERIMA
1 subpiksel terang 3

2 subpiksel terang yang berdekatan 1

3 subpiksel terang yang berdekatan (satu piksel putih) 0

Jarak di antara dua cacat titik terang* >15mm

Total cacat titik terang dari semua jenis 3

CACAT TITIK GELAP
1 subpiksel gelap

TINGKAT YANG DAPAT DITERIMA
5 atau lebih sedikit

2 subpiksel gelap yang berdekatan

2 atau lebih sedikit

3 subpiksel gelap yang berdekatan

0

Jarak di antara dua cacat titik gelap*

>15mm

Total cacat titik gelap dari semua jenis

5 atau lebih sedikit

TOTAL CACAT TITIK

Total cacat titik terang atau titik gelap dari semua jenis

TINGKAT YANG DAPAT DITERIMA

5 atau lebih sedikit

€ Catatan

1. 1 atau 2 cacat subpiksel yang berdekatan = 1 cacat titik
2. Monitor ini sesuai dengan ISO 9241-307. (IS09241-307: Metode pengujian kesesuaian, analisis, dan
persyaratan ergonomis untuk tampilan visual elektronik)




8.2 Layanan pelanggan dan jaminan

Untuk informasi rinci tentang cakupan jaminan dan persyaratan dukungan tambahan yang berlaku di
negara Anda, kunjungi situs VWWeb www.philips.com/support. Anda juga dapat menghubungi nomor
Pusat Layanan Pelanggan Philips setempat yang tercantum di bawah ini.

Informasi kontak untuk kawasan EROPA BARAT:

A

Germany Siemens &S +49 01803 386 853 €009
United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff
Ireland Invec Scotland +353 01 601 1161 Local call tariff
Spain Eatsa Spain +34 902 888 785 €010
Finland A-novo +358 09 2290 1908 Local call tariff
France A-novo +33 082161 1658 € 0,09
Greece Allman Hellas +30 00800 3122 1223 Free of charge
Italy A-novo +39 840 320 041 €0,08
Netherlands E Care +31 0900 0400 063 €010
Denmark A-novo +45 3525 8761 Local call tariff
Norway A-novo +47 2270 8250 Local call tariff
Sweden A-novo +46 08 632 0016 Local call tariff
Poland Zolter +48 0223491505 Local call tariff
Austria Siemens &S +43 0810 000206 €007
Belgium E Care +32 078 250851 € 0,06
Luxembourg E Care +352 26 84 30 00 Local call tariff
Portugal Eatsa Spain +351 2 1359 1440 Local call tariff
Switzerland A-novo +41 02 2310 2116 Local call tariff
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Informasi kontak untuk kawasan EROPA TENGAH DAN TIMUR:

BELARUS NA IBA +375 17 217 3386
BULGARIA NA LAN Service +359 2 960 2360
CROATIA NA Renoprom +385 1 333 0974
ESTONIA NA FUJITSU +372 6519900
LATVIA NA “ServiceNet LV" Ltd. +371 7460399
LITHUANIA NA UAB "Servicenet" +370 7400088
ROMANIA NA Blue Ridge Intl. +40 21 2101969
S ero |NA Kim Tec d.oo. +381 11 20 70 684
SLOVENIA NA PC H.and +386 1 530 08 24
VRN NA Comel +380 562320045
NA Topaz-Service Company | +38 044 245 73 31
R NA CPS +7 (495) 645 6746 (for repair)
NA CEEE Partners +7 (495) 645 3010 (for sales)
Slovakia NA Datalan Service +421 2 49207155
Turkey NA Techpro +90 212 444 4 832
Czech Rep. NA Asupport 800 100 697
Hungary NA Serware ' +36 12426331
NA Profi Service +36 1 814 8080

Informasi kontak untuk kawasan AMERIKA LATIN:

Negara

Brazil

Argentina

Pusat informasi

Vermont

Nomor layanan konsumen
0800-7254101

0800 3330 856

Informasi kontak untuk China:

China

Nomor layanan konsumen: 4008 800 008
Informasi kontak untuk AMERIKA UTARA:

USA.

TOS

O a a

Teleplan

(877) 835-1838

Canada

Supercom

Supercom

(800) 479-6696
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Informasi kontak untuk kawasan APMEA:

Negara Pusat informasi ASC Nomor layanan konsumen
Australia NA AGOS NETWORK PTY LTD | 1300 360 386
New Zealand | NA Visual Group Ltd. 0800 657447
Hong Kong / . Hong Kong:Tel: +852 2619 9639
Macau NA Smart Pixels Technology Ltd. | (1. - Tl (853)-0800-987
. Tel: 1 800 425 6396
India NA REDINGTON INDIA LTD SMS: PHILIPS 10 566477
Indonesia NA PT. Gadingsari elektronika Tel: 62 21 75909053, 75909056,
Prima 7511530
South Korea NA PCS One Korea Ltd. 080-600-6600
: After Market Solutions (CE)
Malaysia NA Sdn Bhd 603 7953 3370
Pakistan NA Philips Consumer Service (9221) 2737411-16
Philips Electronics Singapore
Singapore NA Pte Ltd (Philips Consumer (65) 6882 3999
Care Center)
PCCW
Taiwan Teleservices FETEC.CO 0800-231-099
Taiwan
Thailand NA ftz's Computer System Co. | (051 934.5498
South Africa NA Sylvara Technologies Pty Ltd | 086 0000 888
UNITED ARAB AL SHAHD COMPUTER
EMIRATES NA LLC 00971 4 2276525
Israel NA Eastronics LTD 1-800-567000
. . +84 8 38248007 Ho Chi Minh City
Vietnam NA FCPT SeW'CEt'é‘format'c +84 5113.562666 Danang City
Sl +84 5113.562666 Can tho Province
- . (02) 633-4533 to 34,
Philippines NA Glee Electronics, Inc. (02) 637-6559 1o 60
Sri Lanka NA no dllstrlbutor and/or service
provider currently
Banoladesh NA Distributor: Computer Source | 880-2-9141747, 9127592
S Ltd (warranty buy-out) 880-2-8128848 / 52
Nepal NA Distributor: Syakar Co. Ltd 977-1-4222395
(warranty buy-out)
Distributor: Neat Technology
Cambodia NA Pte Ltd (Singapore) (warranty | 855-023-999992

buy-out)
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9. Mengatasi masalah & Tanya
jawab

9.1 Mengatasi Masalah

Halaman ini menjelaskan tentang masalah yang
dapat diatasi pengguna. Jika masalah terus
berlanjut setelah Anda mencoba solusi berikut,
hubungi staf layanan pelanggan Philips.

E Masalah Umum
Tidak Ada Gambar (LED Daya mati)

* Pastikan kabel daya telah tersambung ke
stopkontak dan ke bagian belakang monitor.

» Pastikan terlebih dulu tombol daya di bagian
depan monitor telah berada dalam posisi
OFF (TIDAK AKTIF), lalu tekan ke posisi
ON (AKTIF).

Tidak Ada Gambar (LED Daya Putih)

»  Pastikan komputer telah dihidupkan.

* Pastikan kabel sinyal telah tersambung
dengan benar ke komputer.

* Pastikan pin pada kabel monitor yang
tersambung tidak tertekuk. Jika ya, perbaiki
atau ganti kabel.

*  Fitur Hemat Daya mungkin diaktifkan

Layar menampilkan

Attention

Check cable connection

* Pastikan kabel monitor telah tersambung
dengan benar ke komputer. (Lihat juga
Panduan Ringkas).

* Periksa pin yang tertekuk pada kabel
monitor.

* Pastikan komputer telah dihidupkan.
Tombol AUTO (OTOMATIS) tidak berfungsi

*  Fungsi otomatis hanya berlaku dalam mode
Analog VGA. Jika hasilnya tidak memuaskan,
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Anda dapat melakukan penyesuaian manual
melalui menu OSD.

€ Catatan

Fungsi Otomatis tidak berlaku dalam mode
Digital DVI karena fungsi tersebut tidak
diperlukan.

Tanda yang tampak seperti asap atau kilatan

api

* Jangan lakukan langkah-langkah apapun
untuk mengatasi masalah

* Lepaskan segera monitor dari catu daya
utama untuk keselamatan

*  Hubungi segera staf layanan pelanggan
Philips.

B Masalah Gambar

Gambar tidak berada di tengah

*  Atur posisi gambar menggunakan fungsi
“"Auto” (Otomatis) dalam Kontrol Utama
OSD.

*  Atur posisi gambar menggunakan Phase/
Clock (Fase/Jam) dalam Setup (Konfigurasi)
di Kontrol Utama OSD. Hal ini hanya
berlaku dalam mode VGA.

Gambar bergetar di layar
Pastikan kabel sinyal telah tersambung dengan
benar dan kencang ke papan grafis atau PC.

Kelip vertikal muncul di layar

*  Atur gambar menggunakan fungsi “Auto”
(Otomatis) dalam Kontrol Utama OSD.

* Hilangkan baris vertikal menggunakan
Phase/Clock (Fase/Jam) dalam Setup
(Konfigurasi) di Kontrol Utama OSD. Hal ini
hanya berlaku dalam mode VGA.

Kelip horizontal muncul di layar

"




*  Atur gambar menggunakan fungsi “Auto”
(Otomatis) dalam Kontrol Utama OSD.

* Hilangkan baris vertikal menggunakan
Phase/Clock (Fase/Jam) dalam Setup
(Konfigurasi) di Kontrol Utama OSD. Hal ini
hanya berlaku dalam mode VGA.

Gambar terlihat buram, tidak jelas, atau terlalu

gelap

*  Atur kontras dan kecerahan di OSD (On-
Screen Display).

"Jejak gambar", "efek terbakar",atau "bayangan"
tetap muncul setelah daya dimatikan.

*  Tampilan gambar diam atau gambar statis
yang tidak berubah dalam waktu lama
dapat menimbulkan “efek terbakar”, disebut
juga “jejak gambar” atau “bayangan”, di
layar. “Efek terbakar”, “jejak gambar”, atau
“bayangan" adalah fenomena umum dalam
teknologi panel monitor. Dalam sebagian
besar kasus, “‘efek terbakar”, “jejak gambar”,
atau “bayangan’ akan menghilang secara
bertahap dalam waktu tertentu setelah daya
dimatikan.

» Aktifkan selalu program screensaver
bergerak bila Anda meninggalkan monitor.

» Aktifkan selalu aplikasi refresh layar berkala
jika Monitor akan menampilkan konten
statis yang tidak berubah.

Nk

*  Gejala "efek terbakar”, “jejak gambar”, atau
"bayangan” yang fatal tidak akan hilang
dan tidak dapat diperbaiki. Kerusakan yang
disebutkan di atas tidak tercakup dalam
jaminan.

Gambar tampak berubah. Teks tidak jelas atau
buram.

*  Atur resolusi layar PC ke mode sama
seperti resolusi asli layar yang disarankan
monitor.

Titik hijau, merah, biru, hitam, dan putih muncul

di layar

» Titik tersisa adalah karakter normal yang
muncul pada liquid crystal yang digunakan
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dalam teknologi saat ini. Untuk informasi
lebih rinci, lihat kebijakan piksel.

Lampu “daya hidup” terlalu terang dan

mengganggu

* Anda dapat mengatur lampu “daya hidup”
menggunakan Konfigurasi LED daya dalam
Kontrol utama OSD.

Untuk bantuan lebih lanjut, lihat daftar Pusat
Informasi Konsumen dan hubungi staf layanan
pelanggan Philips.



9.2 Tanya Jawab SmartControl Lite

P1.  Saya mengganti monitor PC dan
SmartControl Lite menjadi tidak dapat
digunakan.Apa yang harus saya lakukan?

Jawab: Hidupkan ulang PC dan lihat apakah
SmartControl Lite dapat berfungsi.
Jika tidak, hapus dan instal ulang
SmartControl Lite untuk memastikan
driver yang benar telah diinstal.

P2.  SmartControl Lite berfungsi dengan
baik sebelumnya, namun kini tidak lagi.
Apa yang dapat saya lakukan?

Jawab: Jika tindakan berikut dilakukan, driver

monitor mungkin perlu diinstal ulang.

* Mengganti adapter grafis video

* Memperbarui driver video

+ Aktivitas pada OS, misalnya service pack atau
patch

* Jalankan Windows Update serta driver
monitor dan/atau video yang diperbarui

* Boot di Windows dijalankan dengan monitor
dalam kondisi mati atau tidak tersambung.

*  Untuk mengetahuinya, klik kanan My
Computer (Komputer Saya), lalu klik
Properties->Hardware-> Device Manager
(Properti->Perangkat Keras->Manajer
Perangkat).

* Jika "Plug and Play Monitor" (Monitor Plug
and Play) ditampilkan dalam Monitor; Anda
harus menginstal ulang. Hapus dan instal
ulang SmartControl Lite.

P3. Setelah menginstal SmartControl Lite,
bila tab SmartControl Lite diklik, layar
tidak menampilkan apapun setelah
beberapa saat atau layar menampilkan
pesan kegagalan. Mengapa demikian?

Jawab: Adapter grafis mungkin tidak kompatibel
dengan SmartControl Lite. Jika adapter
grafis adalah salah satu merek yang
disebutkan di atas, coba download driver
adapter grafis terbaru dari situs VWeb
perusahaan yang terkait. Instal driver.
Hapus SmartControl Lite, lalu instal
ulang sekali lagi.
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P4.

Jawab:

P5.

Jawab:

Jika tetap tidak berfungsi, kami mohon
maaf bahwa adapter grafis tersebut tidak
didukung. Kunjungi situs Web Philips dan
lihat apakah driver SmartControl Lite
terbaru telah tersedia.

Bila saya mengklik Product Information
(Informasi Produk), hanya sebagian
informasi yang ditampilkan. Mengapa
demikian?

Driver adapter kartu grafis mungkin
bukan merupakan versi terbaru yang
sepenuhnya mendukung antarmuka
DDC/CI. Coba download driver adapter
grafis terbaru dari situs Web perusahaan
yang terkait. Instal driver: Hapus
SmartControl Lite, lalu instal ulang sekali

lagi.

Attention

Check cable connection

Saya lupa PIN untuk Fungsi Theft
Deterrence (Pencegahan Pencurian).
Apa yang dapat saya lakukan?

Pusat Layanan Philips berhak meminta
identifikasi dan otorisasi resmi untuk
menetapkan kepemilikan monitor.

Perlu diketahui bahwa fungsi pencegahan
antipencurian diberikan sebagai pilihan
yang bebas dan mudah. Mengelola nomor
PIN adalah sepenuhnya tanggung jawab
pengguna, baik perorangan maupun
organisasi, yang membuatnya.

Jika lupa nomor PIN, pusat layanan
Philips dapat membuat ulang PIN untuk
Anda dengan membebankan sejumlah
biaya setelah verifikasi kepemilikan.

Perlu diketahui bahwa aktivitas ini tidak
tercakup dalam persyaratan jaminan
standar.



9.3 Tanya Jawab Umum

P1:

Jawab:

P2:

Jawab:

P3:

Jawab:

Sewaktu memasang monitor, apa

yang harus saya lakukan jika layar
menampilkan "Cannot display this video
mode" (Tidak dapat menampilkan mode
video ini)?

Resolusi yang disarankan untuk monitor
ini: 1920 x 1080 pada 60Hz.

Lepas semua kabel, lalu sambungkan PC ke
monitor yang digunakan sebelumnya.

Dalam Windows Start Menu (Menu

Mulai Windows), pilih Settings/Control
Panel(Pengaturan/Panel Kontrol) . Dalam
Control Panel Window (Jendela Panel
Kontrol), pilih ikon Display (Tampilan).

Dalam Display Control Panel (Panel Kontrol
Tampilan), pilih tab "Settings" (Pengaturan).
Dalam tab pengaturan, dalam kotak "desktop
area" (area desktop), gerakkan panel samping
ke piksel 1920 x 1080

Buka "Advanced Properties" (Properti
Lanjutan), atur Kecepatan Refresh ke 60Hz,
lalu klik OK.

Hidupkan ulang komputer, lalu ulangi langkah
2 dan 3 untuk memverifikasi bahwa PC telah
diatur ke 1920 x 1080 pada 60Hz.

Matikan komputer; lepas monitor lama, lalu
sambungkan monitor Philips.

Hidupkan monitor, lalu hidupkan PC.

Berapa kecepatan refresh yang
disarankan untuk Monitor?

Kecepatan refresh yang disarankan
untuk Monitor adalah 60Hz. Jika
terdapat gangguan di layar, Anda
dapat mengatumya hingga 75Hz untuk
mengetahui apakah gangguan tersebut
dapat diatasi.

Apakah yang dimaksud dengan file .inf
dan .icm pada CD-ROM? Bagaimana
cara menginstal driver (.inf dan .icm)?

Ini adalah file driver untuk monitor.
Untuk menginstal driver, ikuti petunjuk
dalam panduan pengguna. Komputer
mungkin akan menanyakan driver
monitor (file .inf dan .icm) atau disk
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driver saat Anda menginstal monitor
untuk pertama kalinya. Ikuti petunjuk
tentang cara memasukkan CD-ROM
pendamping yang disertakan dalam
kemasan ini. Driver monitor (file .inf dan
.icm) akan diinstal secara otomatis.

Bagaimana cara mengatur resolusi?

Kombinasi driver grafis/kartu video dan
monitor akan menentukan resolusi yang
tersedia. Anda dapat memilih resolusi
yang diinginkan dalam Panel Kontrol
Windows® dengan “Display properties”
(Properti tampilan).

Bagaimana jika saya salah melakukan
penyesuaian monitor melalui OSD?

Tekan tombol OK, lalu pilih "Reset" (Atur
Ulang) untuk menggunakan kembali
semua pengaturan pabrik awal.

Apakah layar LCD antigores?

Secara umum, sebaiknya permukaan
panel tidak mengalami guncangan yang
berlebihan dan terlindungi dari benda
tajam atau tumpul. Sewaktu menangani
monitor, pastikan tidak ada tekanan atau
kekuatan berlebihan yang diberikan pada
sisi permukaan panel. Tindakan ini dapat
mempengaruhi ketentuan jaminan.

Bagaimana seharusnya cara
membersihkan permukaan LCD?

Untuk pembersihan normal, gunakan kain
bersih dan lembut. Untuk pembersihan
secara menyeluruh, gunakan isopropil
alkohol. Jangan gunakan bahan pelarut
lainnya seperti etil alkohol, ethanol,
aseton, hexane, dll.

Apakah pengaturan warna pada
monitor dapat diubah?

Ya. Anda dapat mengubah pengaturan
warna melalui kontrol OSD sesuai
prosedur berikut,

Tekan "OK" untuk menampilkan menu OSD
(On Screen Display)

Tekan "Down Arrow" (Panah Bawah) untuk
menggunakan pilihan "Color" (Warna), lalu



9. Mengatasi masalah & Tanya jawab

tekan "OK" untuk membuka pengaturan

warna. Berikut adalah tiga pengaturan yang

tersedia.

1. Color Temperature (Suhu Warna);
Dengan pengaturan dalam kisaran 6500K,
panel menampilkan "hangat" dengan
nada warna merah-putih, sedangkan
suhu 9300K menghasilkan "nada dingin,
biru-putih”.

2. sRGB; Ini adalah pengaturan standar
untuk memastikan pertukaran wama
yang benar di antara berbagai perangkat
(misalnya kamera digital, monitor, printer,
pemindai, dll.)

3. User Define (Ditentukan Pengguna);
Pengguna dapat memilih pengaturan
warna sesuai keinginannya dengan
menyesuaikan warna merah, hijau, dan
biru.

€ Catatan:
Penghitungan warna lampu yang dipancarkan

oleh benda tertentu sewaktu sedang dipanaskan.

Penghitungan ini diberikan dalam persyaratan
skala absolut, (derajat Kelvin). Suhu Kelvin lebih
rendah seperti 2004K berwarna merah; suhu
lebih tinggi seperti 9300K berwarna biru. Suhu
netral adalah putih pada 6504K.

P9:  Apakah Monitor dapat disambungkan
ke PC manapun, workstation, atau Mac?

Jawab: Ya. Semua Monitor Philips kompatibel
sepenuhnya dengan PC, Mac, dan
workstation standar. Anda mungkin
memerlukan adapter kabel untuk
menyambungkan monitor ke sistem Mac.
Untuk informasi lebih lanjut, hubungi staf
penjualan Philips.

P10:  Apakah Monitor Philips memiliki fungsi
Plug-and-Play?

Jawab: Ya. Monitor merupakan perangkat
Plug-and-Play yang kompatibel dengan
Windows 7/Vista/XP/NT, Mac OSX,
Linux

P11:  Apa yang dimaksud dengan Gambar
Menempel, Efek Terbakar, Jejak Gambar,
atau Bayangan pada panel LCD?

Jawab: Tampilan gambar diam atau gambar
statis yang tidak berubah dalam
waktu lama dapat menimbulkan "efek
terbakar", disebut juga "jejak gambar”
atau "bayangan", di layar. "Efek terbakar",
"iejak gambar", atau "bayangan" adalah
fenomena umum dalam teknologi panel
LCD. Dalam sebagian besar kasus, "efek
terbakar", "jejak gambar", atau "bayangan"
akan menghilang secara bertahap dalam
waktu tertentu setelah daya dimatikan.
Aktifkan selalu program screensaver
bergerak bila Anda meninggalkan
monitor.
Aktifkan selalu aplikasi refresh layar
berkala jika Monitor akan menampilkan
konten statis yang tidak berubah.

(D Peringatan

Gejala "efek terbakar", "jejak gambar", atau
"bayangan" yang fatal tidak akan hilang dan tidak
dapat diperbaiki. Kerusakan yang disebutkan di
atas tidak tercakup dalam jaminan.

P12: Mengapa Layar tidak menampilkan teks
yang jelas, namun menampilkan karakter
bergerigi?

Jawab: Monitor berfungsi paling baik pada
resolusi asli 1920 x 1080 @60Hz. Untuk
tampilan terbaik, gunakan resolusi ini.
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